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Abstract 

 Parkinson’s Disease (PD) is the second-most prevalent neurodegenerative disorder after 

Alzheimer’s Disease and affects 680,000 US adults over the age of 45 as of 2010 [Marras et al. 

2018]. This disease results in a loss of dopaminergic neurons, specifically in the substantia nigra. 

PD has also been associated with the accumulation of toxic oligomeric variants of alpha-synuclein 

(-syn). Although there are several medications that can help manage symptoms for PD, there is 

no cure. We have successfully created antibody reagents that selectively target toxic -syn variants 

without binding to non-oligomeric forms of normal alpha-synuclein. However, the blood-brain 

barrier (BBB) is a major obstacle for drug delivery and treatment of PD due to its low permeability 

to foreign objects. Due to the size of the monoclonal antibody, it is unable to cross the BBB without 

transporter proteins or temporary disruption of the BBB. This antibody therapy is delivered using 

novel magnetic resonance guided focused ultrasound (MRgFUS) treatment, which transiently 

disrupts tight junctions between epithelial cells in the BBB, resulting in gaps large enough for the 

antibody therapy to cross the BBB. Results indicate that the BBB was successfully opened over 

multiple timepoints, and the procedure does not cause extensive tissue damage. The results also 

show that the targeted antibody selectively binds to toxic -syn in regions of the brain where the 

BBB has been temporarily disrupted. Future work includes longitudinal studies to determine if this 

treatment combination can delay disease progression or improve quality of life in murine models 

of Parkinson’s Disease. 
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1.0 Background 

1.1 Parkinson’s Disease 

Parkinson’s Disease (PD) is the second-most prevalent neurodegenerative disease in the 

US, with a projected total of 1,238,000 adults over the age of 45 with PD by 2030 [Marras et al. 

2018]. PD causes both motor and non-motor deficits, which fall into a larger category of 

parkinsonian symptoms, including bradykinesia (slower initiation of voluntary movements 

coupled with smaller amplitude of movements), muscular rigidity, and resting involuntary tremors 

for early-stage PD [Sveinbjornsdottir et al. 2016]. Non-motor symptoms are caused by degradation 

of the autonomic nervous system, and include orthostatic hypotension, dizziness, visual 

disturbances, impaired cognition, gastrointestinal symptoms, sleep disturbances, and 

neuropsychiatric symptoms [Sveinbjornsdottir et al. 2016].  

1.1.1 Pathology of PD 

 PD is characterized by the presence of Lewy neurites (LN) and Lewy bodies (LB) in the 

medulla oblongata, substantia nigra, anterior olfactory nucleus, and vagal nerve. These LNs and 

LBs mainly consist of misfolded beta-sheet oligomers of alpha-synuclein. Alpha-synuclein is a 

small protein found in synaptic end terminals that ranges from 127-140 amino acids in length, and 

has three variants: , , and  Although the function of natural -syn is not well understood, 

development of oligomeric beta sheets has been linked to PD and other neurodegenerative diseases 

[Goedert, 2001]. PD stage progression is determined based on the presence of toxic -syn LBs 

and LNs in different brain regions.  

 There are six clinical stages of Parkinson’s disease. Stage 1 shows a small amount of LNs 

present in the dorsal motor nucleus and preganglionic axons of the vagal nerve [Braak et al. 2004]. 

Stage 2 is characterized by damage to the dorsal motor nucleus spreading to surrounding tissue. 
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Stage 2 also marks the start of LBs and LNs present in the coeruleus-subcoeruleus complex. Stage 

2 is also the last stage of PD that does not have disease progression in the substantia nigra [Braak 

et al. 2004]. Stage 3 is the first stage to contain hallmark pathological symptoms of PD, including 

LNs and LBs in the pars compact of the substantia nigra, granular aggregations and LBs that 

generate partially myelinated axons. This stage also shows disease progression from the dorsal 

motor nucleus into surrounding tissue and has spread to the basolateral nuclei. Several other brain 

structures show scattered presence of LNs [Braak et al. 2004]. During stage 4, the cerebral cortex 

contains LNs in the allocortex and neocortex. The disease also spreads to first and third sectors of 

Ammon’s horn. The disease progression through Ammon’s horn is distinctive enough to diagnose 

a patient without further pathology [Braak et al. 2004]. Stages 5 and 6 is characterized by wide-

spread destruction of dopaminergic neurons in the substantia nigra and neocortex. Patients with 

stages 5 or 6 exhibit classic parkinsonian clinical symptoms [Braak et al. 2004]. 

1.1.2 Current Treatment for PD 

 Although there are several clinical trials underway that could help treat or slow the 

progression of PD, there is currently no cure [Abbruzzese et al. 2016]. All available treatment 

methods for PD are to alleviate motor and non-motor symptoms, necessitating a therapy that could 

preventatively target toxic alpha-synuclein LBs and LNs. There are several drug pathways for PD 

treatment, including dopamine precursors and agonists, MAO-B inhibitors, and COMT inhibitors 

[Ellis et al. 2017]. Levodopa, a biosynthetic dopamine agonist, is the current gold standard for PD 

treatment and has been used for parkinsonian symptom management for over 50 years. Despite 

the decades long use of levodopa as a primary treatment method for PD, patients grow resistant to 

treatment over time, either due to pseudo-resistance to dopaminergic medication, progression of 

dopaminergic and nondopaminergic brain lesions, or resistance to levodopa [Nonnekes et al. 
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2016]. PD treatment also includes immunotherapy with monoclonal antibodies being developed 

by several pharmaceutical companies to target -syn. 

 Alternative approaches to PD disease management include deep brain stimulation (DBS), 

exercise programs, physical therapy, ablative surgery, and gene therapy. Although exercise, 

physical therapy, and speech therapy can be clinically useful, further research needs to be 

conducted due to variability in execution and results [DeMaagd et al. 2015]. DBS has gained 

popularity since the first device was approved for treatment in 1997, and is used to reduce tremor, 

dyskinesia, and intractable motor fluctuations. This process involves surgical implantation of an 

electrode in deep brain tissue. DBS has significantly reduced tremors and dyskinesia associated 

with PD, however, more research needs to be conducted to improve targeting, long-term effects, 

and to reduce severe side effects associated with the procedure [DeMaagd et al. 2015]. 

1.2 Antibody Therapy 

 The human immune system consists of innate and adaptive immunity. The innate immune 

system is composed of dendritic cells, natural killer cells (NKs), mast cells, eosinophils, 

neutrophils, and basophils. The innate immune system does not require antigens to function and is 

considered the body’s first line of defense against infection or foreign bodies [Oiseth et al. 2017]. 

The adaptive immune system is composed of B-lymphocytes, helper T cells, cytotoxic T-

lymphocytes, and antigen-presenting cells. Adaptive immunity has two responses: antibody 

response, or cell-mediated response. Each response requires antigen-presenting cells and the major 

histocompatibility complex (MHC) to function [Oiseth et al. 2017]. Adaptive immunity has been 

the focus of medicinal study for decades, and includes medical breakthroughs such as vaccines, 

cancer immunotherapy, and personalized medicine. Immunotherapy using antibodies has also been 

a source of study for neurodegenerative disease.  
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1.2.1 Antibody Physiology and Function 

Antibodies are an immunoglobulin protein produced by B-lymphocytes (B-cells) and are 

responsible for targeted and acute immune response. Antibodies consists of two heavy chains and 

two light chains. Each chain has a variable N-terminal region that can be altered to bind to specific 

antigens and a constant C-terminal. There are 5 different types of antibodies: IgG, IgM, IgA, IgD, 

and IgE, each with its own function [Alberts et al. 2002]. For example, IgG has receptors for 

macrophages, resulting in an antibody that signals antigens for destruction from macrophages and 

neutrophils. In an antibody response, B-cells are activated by helper T cells after the helper T cell 

encounters an antigen. The activated B-cells differentiate into effector cells that secrete antibodies. 

The antibodies have three main functions: flag an antigen or cell for destruction, inactivate viruses 

or microbial toxins, and/or bind to an antigen so that it blocks their ability to bind to a target 

receptor [Alberts et al. 2002]. Antibodies can activate diverse responses due to hinge and tail 

regions, which allow for the antibody to bind to a larger range of distances from each antigen 

binding site and to have unique amino acids that can activate different biological pathways [Alberts 

et al. 2002]. 

1.2.2 Current Applications of Antibody Therapy 

 Although most naturally occurring antibodies are considered polyclonal (i.e. they are 

produced by multiple B-lymphocytes and target a small range of epitopes), the advent of 

monoclonal antibodies (mAbs) shifted the scientific and medical community toward monoclonal 

antibodies as an immunotherapeutic. This shift occurred because mAbs only bind to a single 

epitope, which is ideal for targeted therapy, the mAbs can be reliably reproduced using 

immortalized hybridoma cell lines, and mAbs are less susceptible than polyclonal antibodies to 

conformational changes within the cell [Lipman et al. 2005]. As of 2012, there are 30 FDA 
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approved monoclonal antibody therapies in the US which accounts for $18.5 billion annually in 

sales [Buss et al. 2012]. Although the majority of the monoclonal antibody therapies are used for 

cancer treatment, they are also used for several autoimmune disorders and neurodegenerative 

diseases. Primarily, treatment methods using mAbs involve antibody drug conjugates, where a 

highly specific mAb is conjugated with a cytotoxic drug. This conjugation creates a targeted tumor 

and cancer therapy with high sensitivity and specificity [Buss et al. 2012]. Other therapy 

mechanisms include using mAbs to activate T-cells for specific cell destruction, binding to 

receptors on antigens to prevent targeted cells from binding to receptors or reproducing, or binding 

to antigens to facilitate destruction and clearance. Although mAbs can be an effective treatment 

method, prohibitive costs, short shelf life, and inability to cross the BBB present major obstacles 

that prevent mAbs from seeing broader clinical use. 

1.2.3 Drug Delivery and the BBB 

 The blood-brain barrier (BBB) is a diffusion barrier for the central nervous system that 

selectively allows specific molecules into the brain while keeping most others outside the brain.   

Paracellular flux of small lipophilic and hydrophobic molecules across the barrier and nutrients 

selectively enter the brain via specific transporters. Large molecules can also cross the BBB 

through receptor-mediated endocytosis, which can allow molecules such as insulin to enter the 

brain [Zhang et al. 2001]. Although the BBB has several mechanisms to transport nutrients across 

the diffusion barrier, the BBB is highly regulated, and prevents any molecules that are larger than 

600 Daltons, hydrophilic, and/or have a non-neutral charge from entering the brain [Scherrmann 

2002]. The BBB is composed of endothelial cells, capillary basement membrane, astrocyte end-

feet, and pericytes within the basement membrane. This membrane is unique compared to other 

blood barriers because it is highly impermeable due to a lack of fenestrations. It instead has tight 
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junctions between the endothelial cells, which combined with membrane binding proteins, creates 

a barrier for most blood-borne molecules [Ballabh et al. 2004]. Current methods for getting 

antibodies or other therapeutics across the BBB include intracerebroventricular infusion, 

temporary disruption of the tight junctions via hyperosmotic solution, modification of the molecule 

to take advantage of BBB transporter or receptor pathways, [Scherrman 2002].  Disruption of the 

BBB via focused ultrasound has more recently been developed and is the mechanism being used 

in this work. 

1.3 Focused Ultrasound (FUS) 

High intensity focused ultrasound (HIFU) was first discovered in 1954, where Lindstrom 

and Fry et al. discovered that they could produce high acoustic intensities by focusing ultrasound 

energy on the frontal lobes of several different animal models [Lindstrom et al. 1954]. Not much 

came from these results, and research was abandoned until the 1970s, where HIFU was used to 

induce hyperthermia in tumor cells as a tissue ablation method [Dubinsky et al. 2008]. Despite 

promising results, the method was abandoned because a consistent temperature could not be 

maintained accurately with the current technology. In the 1980s extracorporeal shockwave 

lithotripsy was developed to treat kidney stones. This breakthrough began the development process 

of HIFU as a cancer treatment method for non-invasively ablating cancerous tissue [Dubinsky et 

al. 2008].  

The use of focused ultrasound for BBB disruption was first investigated by Kullervo 

Hynynen et al. in the early 2000s [Hynynen, 2001].  It was discovered that FUS combined with 

ultrasound contrasts agents could temporarily disrupt the BBB, allowing molecules normally 

blocked by the BBB to enter the brain parenchyma. This new approach, termed magnetic resonance 

imaging-guided focused ultrasound (MRgFUS), was revolutionary because it was able to disrupt 
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the BBB using low power levels of FUS, opened the BBB in a temporary and reversible manner, 

was highly reproducible, and did not cause neurological or physiological damage [Hynynen et al. 

2001]. Although research into use of HIFU to disrupt the BBB without microbubbles was pursued 

for several more years, intermittent and inconsistent BBB disruption, higher pressure and power 

levels, and damage to tissue caused most FUS BBB disruption research to shift towards Hynynen 

et al.’s approach to temporary BBB disruption via MRgFUS [Mesiwala et al. 2002]. Since the 

initial publication in 2001, research conducted in the field of MRgFUS has substantially expanded, 

with clinical trials currently underway for MRgFUS-mediated BBB disruption in amyotrophic 

lateral sclerosis patients [Abrahao et al. 2019]. MRgFUS is also in clinical trials for use with 

patients that have Alzheimer’s Disease [Mehta et al. 2021] and oncology applications [Ghai et al. 

2020]. 

1.3.1 Ultrasound Physics 

 The basic principle of diagnostic ultrasound is that pressure waves are generated using 

piezoelectric crystals. The pressure waves propagate through media until the waves are scattered, 

attenuated, absorbed, or the wave encounters an acoustic impedance mismatch that is large enough 

to reflect the pressure wave back towards the transducer [Escoffre et al. 2016]. The ultrasound 

transducer measures the timing difference between propagated and returned waves and the 

intensity of the waves, which allows for image reconstruction. Focused ultrasound uses the same 

principles as diagnostic ultrasound, but does not measure the returned pressure waves, and uses 

higher pressure waves than its diagnostic counterpart [Escoffre et al. 2016]. Focused ultrasound 

can combine the ultrasound transducer with acoustic contrast agent to create stable cavitation of 

the contrast agent in targeted regions. When the ultrasonic pressure waves interact with the 
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microbubble ultrasound contrast agent at the correct frequency and pressures, the BBB can be 

disrupted. 

 Although the exact physiological process to open the BBB is unknown, several 

publications have demonstrated physical triggers that result in BBB opening. Tung et al. 

investigated the physical mechanism of BBB opening and discovered that the pressure needed to 

cause BBB opening without inertial cavitation was highly dependent on microbubble diameter and 

capillary diameter. When both the microbubble and the capillary were of similar diameters, BBB 

opening was achieved [Tung et al. 2011]. These results suggest that reversible BBB opening can 

be achieved when microbubbles oscillate in capillaries without inertial cavitation. The oscillation 

was achieved through pulsed ultrasonic pressure waves between 0.15 MPa and 0.45 MPa at a 

frequency of 1.5 MHz interacting with microbubbles that range from 1-8 m in diameter [Tung et 

al. 2011]. 

1.3.2 Current Application of FUS-Mediated BBB Opening 

 Focused ultrasound has been used to open the BBB in a wide range of applications. The 

most common use is for chemotherapeutics delivery, but it has also been used for delivering viral 

vectors, antibodies, therapeutic nanoparticles, and fluorescent protein-expressing enzymes 

[McMahon et al. 2018]. There are several promising studies and preclinical trials underway, with 

FUS used in BBB disruption for Parkinson’s Disease, functional neurosurgery, treatment of 

chronic neuropathic pain, essential tremor treatment, and treatment for obsessive compulsive 

disorder and depression [Quadri et al. 2018]. This technique has also been used to disrupt the BBB 

to promote clearance of plaque and toxic oligomers in murine models [Poon et al. 2018]. Although 

MRgFUS has been demonstrated as an effective method for drug delivery, further research is 

needed to characterize the pathological mechanism of BBB opening, the effects of MRgFUS on 
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the brain’s glymphatic system, and how mechanical disruption of the BBB could affect oligomeric 

protein formation. 

1.4 Magnetic Resonance Imaging 

Magnetic resonance imaging (MRI) exploits the inherent spin of protons when subjected 

to a magnetic field to create contrast. The spins, which in equilibrium tend to point in the direction 

of the main magnetic field, produce a net magnetization M0.  Specific radiofrequency (RF) pulses 

are used to excite the spin, which rotates M0 from the main magnetic field, creating transverse 

magnetization that oscillates around the main magnetic field at the spin’s Larmor frequency.  The 

oscillating magnetization is collected as the primary signal with tuned radiofrequency receiver 

coils. The resulting information is decoded and transformed into an image [Plewes et al. 2021]. 

The strength of the signal is determined by the amplitude of M0, relaxation times T2*, T2 and T1.  

The first two relaxation times govern how fast the transverse magnetization decays.  T2* is a 

function of field inhomogeneity and spin-spin interactions.  T1 refers to the return of longitudinal 

magnetization to its equilibrium value and is a function of tumbling rate of the molecules being 

imaged. 

1.4.1 Gadolinium-Based Contrast Agents (GBCA’s) 

Since different atoms, molecules, and tissues have different T1 and T2 relaxation times, 

contrast can be created between different tissue types by varying the echo time and repetition time 

(TE and TR respectively) for the experiment. This leads to the three most common types of MRI 

protocols: T1-weighted imaging, T2-weighted imaging, and proton density imaging. [Plewes et al. 

2021]. Although there are numerous pulse-sequences to create variable contrast, it can be 

beneficial to enhance image contrast through the use of contrast agents (CAs). There are two main 

types of CAs: T1 and T2 contrast agents, which are named and categorized based on their effect 
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on T1 or T2 tissue relaxation times [Zhou et al. 2013]. T1 CAs are usually created using a 

biologically safe gadolinium chelate that increases the longitudinal relaxation rate, i.e. decreases 

T1, of surrounding water molecules, thereby creating positive contrast in T1-weighted images for 

water-based signals such as blood or cerebrospinal fluid [Zhou et al. 2013]. These gadolinium-

based chelates are often referred to as gadolinium-based contrast agents (GBCAs). T2 contrast 

agents increase the transverse relaxation rate, i.e. decrease T2, which creates negative contrast (the 

media appears dark compared to surrounding tissue) in T2-weighted images. This effect is 

commonly achieved using superparamagnetic particles such iron oxide nanoparticles [Zhou et al. 

2013]. 

2.0 Purpose of the Current Work 

 Michael Sierks, a professor of chemical engineering in the School for Engineering of 

Matter, Transport and Energy at Arizona State University, developed a novel antibody that can 

bind to toxic oligomeric forms of -syn, without binding to normal, non-toxic forms of -syn. 

Although this antibody has a high affinity for oligomeric -syn, it does not readily cross the BBB. 

This work evaluates our novel FUS setup for temporarily disrupting the BBB, allowing the -syn 

antibody to cross the BBB and enter the brain. The -syn antibody, combined with the novel 

focused ultrasound setup, could be an effective vector for antibody-based therapeutic delivery into 

the central nervous system, which would be a breakthrough in neurodegenerative disease 

treatment. The goal of this project is to characterize the safety, dosage, and feasibility of focused 

ultrasound in combination with the antibody therapy to treat Parkinson’s Disease mice. 



16 

 

2.1 Design of Experiment 

 The experiments conducted in this thesis were completed in two phases. The first phase 

consisted of developing a method for opening the BBB in PD model mice and introducing the 

novel antibody therapy into the mice. These experiments investigated the duration for which FUS 

was applied, FUS safety for PD model mice, histology results after FUS application, and a small 

pilot study with transgenic mice. The pilot study used two transgenic mouse groups: FUS with an 

injection of phosphate-buffered saline (PBS) as a control, and FUS with an injection of antibody 

therapy. The mice received 3 treatment sessions, each spaced two weeks apart, and were sacrificed 

24 hours after their final FUS treatment. After the mice were sacrificed, the tissue was fixed and 

stained for presence of -syn and antibody in the tissue. The pilot study had 2 mice in each group, 

for a total of 4 mice in the study. 

 Phase 2 consisted of a longitudinal study that had 6 different treatment cohorts over a 

course of 12 weeks. The purpose of this study was to investigate the behavioral effects of FUS and 

antibody therapy on PD mice compared to control groups, and to examine -syn and antibody 

presence after multiple treatments. The experimental cohorts are wild-type (WT) behavior only 

(control group), WT with FUS treatment and PBS injection (control group), transgenic (TG) 

behavior only (control group), TG with FUS treatment and PBS injection, TG with antibody (AB) 

injection only (no FUS), and TG with FUS treatment and AB injection. Each cohort will have 6 

mice that have completed the final timepoint. The mice will receive treatment every two weeks, 

and behavior testing on the non-treatment weeks, for a total of 6 treatment sessions and 7 

behavioral timepoints. The cohorts are outlined in Figure 1, and the timeline for the phase 2 study 

are outlined in Figure 2. Due to the complexity and size of the experiment, in addition to 

unanticipated set-backs, the phase 2 longitudinal study is still underway. The results reflected in 
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this thesis are not complete and will be analyzed more extensively once all the experimental 
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cohorts have been successfully completed. 

3.0 Materials and Methods 

3.1 Mouse Model 

The mouse model used in these experiments is the Thy1-aSyn (Line 61) mouse, which 

over-expresses the human -synuclein (-syn) via the mThy-1 promotor. The -syn cDNA 

fragment was generated using RT-PCR from human mRNA and was ligated to pCRII. The 

resulting fragment was inserted in the mThy-1 promotor. The modified promotor was inserted into 

C57BL/6 x DBA/2F1 mice to propagate the modification. Highest expressing lines were bred to 

create a permanent line [Rockenstein et al. 2002]. The -syn cDNA fragment coupled with the 

mThy-1 promotor produces -syn, a foreign protein that is not seen in wild-type mice. Since Line 

61 mice show -syn accumulation accompanied with autonomic deficits at as young as 3 months 

of age, it is especially useful for examining Parkinson’s Disease in its early stages. Additionally, 

Line 61 is a useful murine model for PD pathology. Line 61 -syn accumulation was present in 

the substantia nigra pars compacta, thalamus, and several other brain regions consistent with 

human PD pathological findings [Chesselet et al. 2012]. 

3.1.1 Behavior 

 Line 61 mice exhibit signs of dopaminergic neuron loss starting at 6 months of age. The 

loss of dopamine is correlated with behavioral changes, such as hyperactivity in the open field test. 

After 6 months of age, move time, movement velocity, and distance traveled increased 

significantly in transgenic (TG) mice compared to wild-type (WT), with a dramatic decrease in 

number of movement episodes in TG mice compared to WT control [Chesselet et al. 2012]. TG 

Line 61 mice also show olfactory deficits as demonstrated by Chesselet et al. Line 61 mice show 
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several autonomic deficiencies, including constipation, disrupted circadian rhythm, increased 

anxiety, and mild cognitive deficits [Chesselet et al. 2012]. 

 Line 61 also exhibits several motor deficits, as outlined by Fleming et al. 2004. They 

discovered that TG mice weighed significantly less than WT counterparts. TG mice also performed 

worse than WT mice during the beam traversal test. As TG mice aged, performance in the beam 

traversal test decreased [Flemming et al. 2004]. TG mice showed several other motor deficits, 

including longer times to descend during the pole test, fewer instances of spontaneous rearing and 

grooming, and have worse fine motor skills as measured with the cotton bedding usage test 

[Flemming et al. 2004]. These results indicate that TG Line 61 mice experience motor deficits that 

can be attributed to pathological accumulation of -syn in cortical and sub-cortical regions, 

specifically the substantia nigra [Flemming et al. 2004]. 

3.2 Antibody 

 The Sierks lab at Arizona State University has developed a technology that allows them to 

isolate and characterize protein morphologies. They have used this technology to isolate and 

characterize toxic oligomeric forms of -syn. Using this -syn characterization, they investigated 

the use of a single-chain variable fragment (scFV) to target toxic oligomeric forms of -syn. The 

results of this study demonstrated that the scFV D5 antibody fragment was able to target toxic 

oligomeric forms of -syn and did not bind or react to non-toxic forms of -syn. Results indicate 

that the scFV D5 antibody fragment facilitates the clearance of toxic -syn, which has been 

demonstrated in previous studies [Spencer et al. 2014]. In the current project, the Sierks lab has 

taken their antibody fragment and converted it to a full-length IgG antibody. The IgG format has 

a higher approval rate for clinical trials, has a longer half-life, and has a larger database of literature 

investigating full-length IgG antibodies as a therapeutic. Since the full-length antibody format is 
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approximately 70 kDa, it will not cross the BBB on its own. To facilitate crossing, a penatratin-

based peptide tag was added to the C-terminal of the antibody heavy chain, which has been shown 

in previous work at the Sierks’ lab [Spencer et al. 2016]. 

3.3 FUS Hardware and Protocols 

 
 This project is an extension of earlier work conducted by Valdez et al. at the University of 

Arizona. The previous project investigated distribution and diffusion of macromolecules through 

the brain after the BBB was disrupted via focused ultrasound [Valdez et al. 2020]. They used 

ultrasonic pressures ranging from 0.18-0.48 MPa to open the BBB in mice aged 6 weeks or older. 

After BBB disruption, they injected fluorescent-tagged dextran molecules of 3 different molecular 

weights (MW) (3, 70, and 500 kDa) into the mice through intravenous (IV) injection. Mice were 

imaged using MRI to determine the extent of BBB disruption at different pressures and with 

different molecular weight strands of dextran. The mice were sacrificed 20 minutes after IV 

injection and prepared for fluorescence microscopy [Valdez et al. 2020]. Results indicated that the 

BBB was opened without tissue damage between 0.26 MPa and 0.11 MPA and did not have BBB 

opening at pressures lower than 0.11 MPa. Diffusion results indicated that smallest MW dextran 

strands diffused readily through the tissue after BBB disruption for all tested pressure values. 70 

kDa strands passed through the BBB but did not diffuse as readily through the tissue as with 3 kDa 

strands. 2000 kDa strands did not pass through the BBB at any pressure. They also discovered that 

there was greater rate of diffusion for the 1.1 kDa, 3 kDa, and 70 kDa strand when exposed to 

higher levels of pressure (up to 0.42 MPa). Increasing pressure did not have a significant increase 

on diffusion of the 500 kDa strand. Much of the FUS protocol, apparatus, equipment, and theory 

was developed using Valdez et al.’s previous work, and the current project would not have been 

successful without their contributions. 
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3.3.1 Scanning FUS 
 As mentioned in Valdez et al.’s paper, diffusion was limited for molecules approximately 

70 kDa in size. Since our experiment uses full-length IgG antibodies, we do not expect high rates 

of diffusion through the surrounding tissue. To increase the amount of antibody that is penetrating 

the tissue, we are using a scanning method to move the FUS transducer during FUS application. 

This approach will open a larger region of the BBB barrier, allowing for more diffusion of the 

antibody into the brain. Additionally, in the previous work, Valdez et al. discovered small lesions 

and damage to tissue intermittently during histology, even with the lower pressures of 0.11 MPa 

and 0.26 MPa. Although mice survived and did not have neurological impairment after these 

procedures, prolonged periods of FUS in one location could lead to tissue damage. To lower 

chance of adverse effects, the FUS was applied for 30 seconds (compared to 2-minutes as 

demonstrated in Valdez et al.) in a scanning pattern across the brain, meaning that each region of 

tissue will only be exposed to FUS for several seconds. An additional change was that the 

transducer is no longer placed in DI water. Instead, Aquasonic gel is applied to the transducer and 

the acoustic window such that there is no air or gaps between the transducer and the acoustic 

window. This setup has allowed for a much more efficient experiments while maintaining 

appropriate acoustic propagation and BBB opening. 

3.3.2 Technical Specifications of FUS Apparatus 
 

The focused ultrasound setup consists of a single-element transducer with a diameter of 22 

mm, a focal length of 19 mm, and a frequency of 2.1 MHz. The beam geometry was characterized 

an Onda HGL-0200 hydrophone connected to an AH-amplifier. The beam profile has a radial full-

width half-max of 4.1 mm and 1.2 mm and an approximately Gaussian shape [Valdez et al. 2020]. 

The transducer was connected to a custom ultrasound driver built by Synergy Electronics. This 

driver allowed for the duty cycle, duration, and power of the FUS setup to be controlled. The FUS 
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driver was connected to a waveform generator and an oscilloscope, to create an overall FUS device 

that had a 1 % duty cycle of 10 ms pulses, 2.1 MHz frequency, and power of 10 W/m2. 

 The platform consisted of a 3D-printed bed with an opening that allowed the mice to lay 

supine on the platform with the cranium over the transducer. There is a small nose cone that is 

connected to anesthesia to cover the mouse’s nose when laying supine, which allows for anesthesia 

delivery and helps to prevent movement of the head during FUS application. The transducer is 

connected to a micrometer adjustment stage that allowed for repeatable movements of the 

transducer across the acoustic window and is located approximately 17 mm below the acoustic 

window. Aquasonic ultrasound gel is applied to the transducer until the gel reaches the interior of  

the mouse bed. The gel is then visually checked for air bubbles or lack of coverage before FUS 

treatment (see Figure 3). 



23 

 

 

3.4 Microbubbles 

The microbubbles used in this experiment were prepared by Dr. Terry Matsunaga, 

professor of medical imaging and adjunct professor of biomedical engineering, following the 

synthesis outlined in Valdez et al. 2020. The microbubbles were prepared at least 1 day in advance 

using a mixture of 1,2-dipalmitoyl-sn-glycero-3-phosphocholine (DPPC), 1,2-dipalmitoyl-sn-

glycero-3-phosphate (DPPA), and 1,2-dipalmitoyl-sn-glycero-3-phosphoethamolamine-N-

polyethyleneglycol-2000 (DPPE-PEG-2000). The solution was dissolved in propylene glycol by 
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heating to 60o C. Solution was reconstituted with normal saline and glycerol. After synthesis, the 

final lipid concentration was 1 mg/mL. The colloids are then placed in 2 mL vials and sealed. The 

headspace was degassed and purged using perfluorobutane to create a final enrichment of 92 % or 

higher. 

3.5 Behavior Evaluation of PD Mice 

 To investigate the effects of AB and FUS treatment on PD mice, behavior testing was 

conducted every two weeks. The behavior test battery consisted of 7 individual tests: weight 

measurement, tremor evaluation, fecal production, quadrant test, clasping test, coat-hanger test, 

and wall-touch tests. Fecal production is measured as each individual pellet in a 15-minute time 

frame during testing. Wall touches and quadrant tests are conducted at the same time.  The mouse 

is placed into a small cage with quadrants outlined underneath the cage. Once the mouse is placed 

in the cage, the number of times it moves to a different quadrant, and the number of times its paw 

or nose touches the wall are recorded for 2 minutes (see Figure 4, Figure 5). For the clasping test, 

mice are picked up by their tail and held approximately 1 ft above their cage for 1 minute. During 

the test, the number of times the mouse grabs a rear limb or clasps its front paws together is 

recorded (see Figure 6). The coat hanger test consists of placing a mouse on a coat hanger that is 

suspended in air. The number of paws used to grab onto the coat hanger determine the score (1-4 
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paws = 1-4 points). If the mouse is able to climb up towards the top of the coat hanger, it receives 

a top score of 5 points. This test is conducted twice, and the average score is recorded (see Figure 

7).  

 The results of the behavior tests are graphed as the metric being tested (i.e number of wall-

touches in 2 minutes, number of clasps in 1 minute, etc.) vs. the mouse age in weeks, resulting in 

a graph with a behavioral timepoint every two weeks on the x-axis, starting at 7 weeks of age. The 

graphs are created by taking the average value over all the mice in a cohort, meaning there are 6 

datapoints at each timepoint, one for each cohort. The error bars are calculated using mean squared 
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error, with the N equal to the number of mice in the cohort that successfully completed all testing 

and behavior timepoints. Since the phase 2 project is still on-going, the behavior results are only 

preliminary, N is different for each group (see Figure 1 for group sizes). Because of the preliminary 

nature of these data no further statistical analysis was conducted. 
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3.6 BBB Opening 

 At the beginning of each BBB opening experiment, mice are anesthetized, their head is 

shaved, and a catheter is placed in the tail vein and secured with suture. The mice then receive an 

intraperitoneal (IP) injection of MultiHance, a gadolinium-based contrast agent, at a dose of 6.4 

mL/kg. Prior to microbubble injection, the microbubbles are activated by placing the sealed vials 

in an amalgamator where they are shaken for 45 seconds at 4,500 RPM. The mice are placed supine 

on the FUS platform, with their head placed over the acoustic window (located directly above the 

FUS transducer, see Figure 8).  The mice receive a weight-calculated dose of microbubbles 

(0.2L/g of body weight) followed by a phosphate-buffered saline (PBS) flush to ensure all 
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bubbles have been injected. Immediately following the PBS flush, FUS is initiated and runs at a 

1% duty cycle for 30 seconds. While the FUS is running, the FUS transducer stage is moved 5 mm 

right to left, 1 mm posterior, and 5 mm left to right. The result is an area of FUS application 

approximately 10 mm2. Immediately after FUS application, mice are transferred to the Bruker 

BioSpec 7T MRI for imaging. 

3.7 Imaging Protocol 

The MRI uses an 86-mm bird quadrature cage coil for RF transmission, and a 4-element 

receive-only mouse brain phased array head coil for signal reception.  The mice are placed in a 

prone position inside the bore of the magnet, secured using a bite bar and ear bars, and kept 
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anesthetized with isoflurane flowing through an MRI-compatible nose cone.  Respiration is 

monitored via a pressure transducer mounted under the mouse and temperature is measured in the 

rectum via a fiberoptic temperature sensor.  The temperature of the mouse is maintained using a 

heated pad that is secured over the animal during imaging. The imaging protocol contains a 

localizer (256 x 256 x 1 pixels, 2D FLASH. TR = 100 ms, TE = 3 ms, 128 phase encoding steps, 

[128,0,0,0] acquisition matrix]), followed by a T1-weighted MRI acquisition. The acquisition is a 

coronal 2D T1-weighted RARE (64 x 128 x 21 pixels, 0.2 x 0.2 x 0.6 mm voxels, 0.6 mm slice 

thickness, TR = 600 ms, TE = 8 ms, number of averages = 16, phase encoding steps = 64, echo 

train length = 2, 180o flip angle).  

3.8 Image Analysis 

 
After FUS treatment and imaging, the MR images are transferred to an offline computer 

for processing and analysis. First, the mouse brain is manually outlined using Mango software 

[Kochunov et al. 2002] on the coronal 2D T1 RARE images. Once the brain has been highlighted, 

it is removed from the surrounding tissue in the image using a masking operation in Mango. Once 

the brain has been extracted, the hyperintense region of BBB opening is highlighted following the 

same steps as outlined above. Once this region of interest (ROI) containing the area of BBB 

disruption has been highlighted, the surrounding brain tissue in the image is removed, leaving only 

the ROI.  

Once the images have been traced using Mango, the resulting images and ROIs are resliced 

and resized to match a template mouse brain (Dorr-Steadman-Ullmann-Richards-Qiu-Egan100 

m isotropic compiled T2 standard mouse brain template image series). The resolution of our MR 

images was 200 x 200 x 600 m and were resliced using MRTrix3 [Tournier et al. 2019] image 

processing toolkit. Using MRTrix3’s “mrgrid” command, the software linearly interpolates the 
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image to match a template image. It changes the voxel size from 200 x 200 x 600 m to 100 x 100 

x 100 m isotropic. It additionally changes the header information so that the spatial voxel 

dimensions match the template image. This process is duplicated for the ROI of BBB opening. 

3.8.1 Image to Atlas Registration 

 After the images have been resized, the images are registered to the standard template 

image using FSL FLIRT [Smith et al. 2004]. FLIRT (FMRIB’s Linear Image Registration Tool) 

is a robust and automated process that performs an affine transformation on the image to match it 

spatially as close to the reference image as possible. The registration process uses nearest-neighbor 

interpolation when applying the affine transformation matrix to the original images. The result is 

an image that has been registered to match the template image. The original MRI image can be 

directly mapped to the reference template image or an atlas that is registered to the template image 

(see Figure 9). 
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3.8.2 Longitudinal Registration 

 Since this project requires multiple FUS treatments on each animal, the registered ROIs 

can all be overlayed onto a single template image, allowing for a simple method to track BBB 

opening locations over time. Additionally, the extent of BBB disruption can be indirectly measured 

by normalizing the MRI image intensity of normal tissue compared to regions of BBB opening. 
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Once the images have been through the processing steps outlined above, the BBB opening ROI 

intensity can be compared against a manually selected region of normal brain tissue. The percent 

increase between normal brain tissue and the hyperintense region can be used to show percent 

opening of the BBB relative to other mice.  

3.9 Perfusion and Histology 

Perfusion was and will be carried out Christine Howison, a member of the Trouard Lab.  

Histology was and will be carried out in the lab of Michael Sierks at ASU.  General methods are 

described here to have a documentation of methods in this Thesis. 

At the conclusion of imaging and therapeutic studies, mice are anesthetized using 

isoflurane gas. While anesthetized, the thorax of the mouse is opened and mice are transcardially 

perfused using cold saline, followed by 4% PFA in PBS.  After perfusion, the brains are excised. 

The brains are immersion-fixed in 4% PFA in PBS (7.4 pH). The brains are stored in sucrose 

solution at 4o C until ready for sectioning. Fixed brains are sectioned at 40 m using a vibratome. 

The sections are incubated with antibodies against -syn. The antibodies consist of D5, which is 

an anti-flag protein that binds to the IgG antibody, and 10H, which binds directly to toxic -syn. 

The sections are stained with cresyl violet (which stains neurons) and viewed using laser scanning 

confocal microscopy.  
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4.0 Results 
4.1 Behavior 

The results from behavior experiments are included in Figures 10-15.  Metrics derived from 

behavior experiments are plotted versus mouse age, starting at 7 weeks of age, and finishing at 19 

weeks of age.  Experiments were carried out on 6 different groups of mice: wild-type (WT) 

behavior only (light green); WT FUS with PBS injection (dark green); Transgenic (TG, line 61) 

behavior only (light blue); TG antibody (AB) injection only (yellow); TG FUS with PBS injection 

(dark blue), and TG with FUS and AB injection (orange). Figure 10 plots the average number of 

quadrants explored during the 2 minute testing period.  Generally, there is a decrease in quadrants 

explored with age. Figure 11 plots the number of wall-touches during the 2 minute testing period 

at different ages.  Similar to the quadrant test, there is a general decrease in the number of wall-
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touches with age. Figure 12 plots the number of clasps during the 1 minute testing period.  In 

contrast to the exploration and wall touches, these results remain relatively constant for each cohort 

versus mouse age. Figure 13 plots the results of the coat hanger test.  Numbers remain relatively 

consistent over age, except for the TG mice receiving antibody only, where a decrease over time 

is observed. Figure 14 plots the animal’s weight versus age.  There is an approximate linear 

increase in mouse weight for all groups over the age studied and not much difference between 

groups.  WT mice tend to be slightly heavier than the TG mice.  Figure 15 plots fecal output during 

the 15-minute testing period.  After an initial decrease, results remain consistent with age with no 

difference between groups.    
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4.2 MRI Results 

The results from the FUS experiments are included in Figures 16 and 17. Figure 16 shows 

results from several different mice, each of which received a different FUS treatment. Figure 16A 

shows a coronal 2D T1-weighted RARE (64 x 128 x 21 pixels, 0.2 x 0.2 x 0.6 mm voxels, 0.6 mm 

slice thickness, TR = 600 ms, TE = 8 ms, number of averages = 16, phase encoding steps = 64, 

echo train length = 2, 180o flip angle) from a mouse that received 2 minutes of focused ultrasound 

in one location. In Figure 16A it can clearly be seen that there is a hyperintense area of signal left 

of the midline. This hyperintense region is due to the presence of gadolinium-based contrast agent 

leaking into the brain. Under normal physiological conditions, GBCA’s are too large to cross the 

BBB, meaning that GBCAs are normally used to highlight cerebrospinal fluid, vasculature, and if 
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there is hemorrhaging in the brain. The presence of GBCAs in regions where FUS was applied 

indicates that the BBB was disrupted enough to allow the GBCAs to cross the BBB.  

Figure 16B is a coronal 2D T1-weighted RARE with the same imaging parameters listed 

above. This mouse received 2 minutes of FUS in a rostral to caudal grid, which was accomplished 

by moving the translational stage during FUS treatment. The hyperintense region inside the brain 
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shows the scanning pattern and indicates that the BBB was successfully opened. Figure 16C is a 

coronal 2D T1-weighted RARE. This mouse received 30 seconds of FUS in a scanning pattern 

rostral to caudal, similar to Figure 16B. The hyperintense region towards the hindbrain indicates 

that the BBB was successfully opened. Figure 16D is an axial 2D T1-weighted RARE. This image 

shows a cross section of a mouse brain that received 2 minutes of FUS administered in the method 

outlined in Figure 16B. The hyperintense regions in the brain indicate that the BBB was 

successfully disrupted, and that the FUS penetrates through the whole brain. 

Figure 17 shows the region of BBB disrupted during FUS treatment on one mouse (mouse 

number 8030). The region of interest (ROI) is placed onto a template image during post-processing 

as discussed previously. Figure 17A shows an ROI of BBB opening during the first FUS treatment 

on mouse 8030. Figure 17B shows an ROI of BBB opening during the second FUS treatment on 

mouse 8030. Figure 17C shows an ROI of BBB opening during the third FUS treatment on mouse 

8030. Figure 17D shows an ROI of BBB opening during the fourth FUS treatment on mouse 8030. 

Figure 17E shows an ROI of BBB opening during the fifth FUS treatment on mouse 8030. Figure 

17F shows an ROI of BBB opening during the sixth FUS treatment on mouse 8030. Figure 17G 

shows All of the ROIs from the 6 treatments overlayed onto the same template image. Similar to 

Figure 17G, Figure 17H shows all of the ROIs overlayed onto the template image, but at a different 

slice of the template image. 
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4.3 Histology 
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 The results from the histology staining are included in Figures 18-21. Figure 18 is a 

histology slice from a transgenic male mouse that received PBS and FUS. The mouse received 3 

treatments, each spaced 2 weeks apart. The FUS was applied for 2 minutes in the scanning method 

during each treatment. This slide shows an axial section of brain tissue that has been stained with 

10H, an antibody that binds to -syn, staining the -syn brown. Figure 18 shows a uniform 

distribution of -syn throughout the tissue, with occasional dark brown spots which are Lewy 

Bodies. Figure 19 is a histology slice from the same transgenic male mouse as Figure 18. Figure 

18 shows an axial section of brain tissue that has been stained with D5, an anti-flag protein that 

binds to therapeutic antibody. Since this mouse did not receive antibody therapy, the brown 

staining present in the image is background levels 
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Figure 20 is a histology slice from a transgenic male mouse that received AB and FUS 

therapy every 3 weeks for a total of 3 treatments. This mouse received 2 minutes of FUS in the 

scanning method as previously discussed. The slide has been stained with 10H antibody, which 

binds to -syn in the brain tissue, staining it brown. Notice the clear outline can be seen where the 

antibody has bound to -syn in the tissue. Figure 21 is a histology slice from the same mouse from 

Figure 20, but this slide was stained with D5, which is an anti-flag protein that binds to the 

therapeutic antibody. Similar to Figure 20, Figure 21 has a clear distinction between areas of 

positive staining for antibody and the background signal levels. 
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5.0 Discussion 
5.1 Behavior 
 Although the results from the behavior experiments are not complete (Each cohort still 

needs several more mice in each category to decrease error and enhance repeatability), there are 

some trends that are consistent between several groups. As described by Chesselet et al., the 

transgenic mice experience several physical and behavioral difference when compared to wild-

type mice, such as presence of tremor, lack of fine motor skills, constipation, bradykinesia, and 

weight loss. 

 When examining behavior results for the number of quadrants explored and wall touches 

during a two-minute period, a trend can be seen in several groups. The graph in Figure 11 shows 

that wild type mice that only received behavior testing or wild-type mice that received FUS and 

PBS (light and dark green lines respectively) habituate quickly during the experiment, meaning 

that after the 3rd round of behavior tests, the average number of quadrants explored was 10, a 

marked decrease from the initial value of 23 and 18 (for light and dark green respectively). The 

habituation for wild type groups continues over time, with a downward trend in the number of 

quadrants explored for both light and dark green groups. At the final timepoint for testing, the 

average number of quadrants for light green was 1.75, and the average for dark green was 2.33. 

 Interestingly, the transgenic mouse groups displayed two distinct results during the 

quadrants test. In Figure 11, transgenic mice that only received behavior testing (light blue) and 

transgenic mice that received antibody treatment (yellow) did not seem to habituate when exposed 

to the test multiple times. These two groups had statistically significant differences between the 

WT control groups (light and dark green). The TG behavior only and TG AB only maintained a 

higher average number of quadrants explored, with the final timepoint having an average of 13 

quadrants explored for the TG behavior only group and an average of 15.75 quadrants explored 
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for the TG AB only group. These results indicate that the mice are not becoming familiar with 

their environment during repeated exposures, suggesting that these mice experience cognitive 

function deficits. 

 The transgenic mouse groups that received focused ultrasound had a different trend than 

the TG behavior only and TG AB only groups during the quadrants test. In Figure 11, TG FUS 

mice that received PBS (dark blue) and TG FUS mice that received AB (orange) habituated faster 

than the other transgenic groups and had average number of quadrants explored similar to WT 

mouse groups. The habituation of TG FUS PBS and TG FUS AB mice is within the standard error 

for the WT groups, meaning that the TG mice are behaviorally normal compared to WT groups. 

These results indicate that FUS could have potential therapeutic uses both with and without the 

addition of antibody therapy.  

 A similar trend to the quadrant test is shown in the wall-touches test. In Figure 12, wild-

type control groups (behavior only is light green and PBS FUS is dark green), TG FUS mice that 

received PBS (dark blue), and TG FUS mice that received antibody treatment (orange), show 

habituation over time. Although all groups started at an average between 18 and 24 wall touches 

during the test, the average number of wall touches decreases with multiple exposures to the test 

for the groups mentioned above (WT behavior, WT FUS, TG PBS FUS, TG AB FUS). Final 

timepoints for these groups show an average between 1.67 and 5.5 wall touches during the test. 

The results conclude that transgenic behavior for these TG groups is within a normal range of 

behavior compared to WT mice, and do not have a cognitive deficit. 

 The same trend as seen in Figure 11 is present in Figure 12 with the TG AB (yellow) and 

TG behavior only (light blue) mouse cohorts. Figure 12 displays a trend among the TG AB and 

TG behavior only cohorts that these cohorts do not habituate as quickly as the other cohorts. When 
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examining Figure 12, TG behavior only group starts at an average of 18.4 wall touches, and ends 

with an average of 13.67 wall touches, which is higher than focused ultrasound groups and the WT 

controls. It can also be seen that the TG AB cohort (yellow) does not habituate as quickly as the 

other groups (excluding TG behavior only). The TG AB group starts at an average of 22 wall 

touches, and decreases to an average of 12 wall touches, which is higher than the focused 

ultrasound or WT groups. The results in Figure 12 suggest that the transgenic behavior only and 

transgenic AB groups have cognitive deficits when compared to the focused ultrasound groups or 

the control groups. 

 Additional trends can be seen in Figure 14, which shows the cohort averages for the coat 

hanger test. This test is designed to test a mouse’s fine motor skills, meaning a mouse without 

motor deficits should be able to climb to coat hanger with all its limbs, and consequently will 

receive a higher score than a mouse with motor deficits that cannot climb as easily. Figure 14 

shows that WT behavior only (light green), WT PB FUS (dark green), TG behavior only (light 

blue), TG PBS FUS (dark blue), and TG FUS AB (orange) score higher on the coat hanger test 

than the TG AB only (yellow) cohort. These results indicate that the TG AB mouse cohort is 

experiencing motor deficits such as tremor or lack of fine motor skill that attribute to a lower 

average score for the group. Interestingly, all of the other transgenic cohorts performed better in 

this test, meaning the exact reason for the TG AB group’s low score cannot be simply ascertained. 

 Although other behavior tests were performed and their results recorded, the trends 

represented in these behavior tests do not vary between cohorts, meaning that the transgenic mice 

in all cohorts performed similarly to the wild-type controls. This suggests that there is not a 

measurable difference between the groups in the weight, clasping test, or fecal output test, and that 

the transgenic mice are behaving normally. 
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5.2 MRI and FUS 

The purpose of this project was to not only determine if FUS could be used to deliver 

therapeutic antibody in the brain, but also to evaluate and characterize the parameters used to 

disrupt the BBB. In the paper by Valdez et al., FUS was applied in a single location for two minutes 

at varying pressures. In these experiments, different parameters were investigated to lower the 

potential damage of FUS on the mouse. After FUS treatment, the mice were imaged using the 

method described earlier to determine the extent of BBB disruption. The results indicated that our 

FUS procedure successfully disrupts the BBB and is reproducible over multiple timepoints. 

 Although Valdez et al. determined that at the correct parameters, application of focused 

ultrasound for 2 minutes in one location was considered safe and had minimal tissue damage, these 

results were concluded from wild-type mice, not PD model mice. When trying to duplicate the 

results of Valdez et al.’s FUS parameters, there were a large number of FUS-related mouse deaths 

when the transducer was stationary in one location for 2-minutes (see Figure 16A). Assuming that 

2 minutes of stable cavitation of the microbubbles in one spot led to hemorrhaging or damage to 

the brain tissue, the protocol was adjusted to incorporate a scanning movement pattern during the 

2 minutes of FUS application. This new approach started rostral and scanned left to right across 

the brain, moving caudally after completion of a row (see Figure 16B). This image is significant 

because it demonstrated that only a few seconds of FUS application was necessary to cause BBB 

disruption, meaning that the transducer could be scanned across the brain, or could be applied for 

a total of 5 seconds or less and still achieve BBB opening. 

 Figure 16C shows the same scanning method as Figure 16B but shortened to 30 seconds 

of FUS application. Although survival rates increased when the FUS application method was 

changed to the scanning method as shown in Figure 16B, there were still a significant number of 
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transgenic mice that were dying after FUS procedure. To reduce the percentage of BBB disrupted 

during a treatment session, the amount of FUS was reduced from 2 minutes to 30 seconds of 

focused ultrasound treatment. The hyperintense region caudal to the midbrain in Figure 16C shows 

that the BBB was successfully disrupted and has a smaller total volume of disruption than the 

results shown in Figure 16B. Reducing the amount of FUS to 30-seconds greatly increased the 

survival rate of transgenic mice, and this FUS parameter was implemented for all subsequent 

experiments. 

 Figure 16D is an axial cross-section of a mouse that received 2-minutes of focused 

ultrasound in a scanning pattern as shown in Figure 16B. It can be clearly seen in this image that 

the hyperintense regions where the BBB has been disrupted extend dorsal to ventral and 

encapsulate the entire dorsal and ventral portions of the brain. This indicates that the focused 

ultrasound beam is not significantly attenuated by the skull, sinuses, or tissue, and that it propagates 

through the tissue with a large enough acoustic pressure to cause stable cavitation in the 

microbubbles throughout the entire depth of the brain. Additionally, the hyperintensity is relatively 

constant dorsal to ventral, which suggests that similar extents of BBB disruption were present 

throughout all of the tissue that was exposed to FUS. 

  An additional component of this project was to determine the effects of FUS 

longitudinally, and to investigate if multiple treatments of FUS would have a therapeutic benefit 

for PD mice. In order to track the regions of BBB opening during each treatment session, the MRI 

images are processed using the method outlined previously. Figure 17 shows a transgenic FUS 

PBS mouse that received FUS therapy every two weeks for a total of 6 treatment sessions. Figure 

18A shows template T2 image with the region of BBB disruption (shown in blue) overlayed onto 

the template image. Figure 17A-F are the locations of BBB disruption for each treatment. The 
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ROIs can also be overlaid onto the template image, so that all BBB disruptions can be viewed 

simultaneously, as shown in Figure 17G. This image shows that the ROIs are 3D, and accurately 

capture the location and extent of BBB disruption through the whole brain. 

5.3 Histology 

 After completion of the study, the mice were sacrificed, and their brains excised. The brains 

were prepared for tissue staining and sent to Arizona State University, where the tissue was sliced, 

stained, and imaged. Since this is an ongoing project, not every mouse that has completed the study 

has been evaluated for neuronal health, so broader trends and conclusions from the histology 

results are not yet available. However, there have been several brains sent to ASU which have 

yielded surprising results about the focused ultrasound procedure and the treatment method. 

 Figure 18 shows a uniform distribution of -syn throughout the tissue, with occasional 

dark brown spots which could be Lewy Bodies. This image confirms that the transgenic mice over-

express -syn, and that focused ultrasound with PBS alone will not trigger clearance mechanisms 

to remove toxic -syn. 

 Figure 19 was stained with D5, which is an anti-flag protein that binds to the therapeutic 

antibody Since this mouse received PBS solution, it did not have any therapeutic antibody in the 

tissue. The brown staining shown in Figure 19 is background-levels of staining in the tissue. These 

results indicate that we are staining for the antibody, and shows that there is no discernable 

physiological difference in staining caused by the focused ultrasound treatment alone. 

 Figure 20 has been stained with 10H antibody, which binds to -syn in the brain tissue, 

staining it brown. Interestingly, a clear outline can be seen where the antibody has bound to -syn 

in the tissue. This is of similar shape and size to the region of BBB opened during the final therapy 

session (see Figure 16D). This image is significantly different than Figure 18, which depicts a 
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similar tissue slice with the same staining, but with a PBS FUS treatment protocol instead. 

Although it can be difficult to directly compare staining intensity or gain quantitative results from 

histology, the clear demarcation between regions that contain -syn and regions that contain 

significantly less -syn is a dramatic indication that the FUS AB treatment is having a pronounced 

effect on -syn accumulation compared to FUS PBS treatment. 

 Figure 21 was stained with D5, which is an anti-flag protein that binds to the therapeutic 

antibody. This image also has interesting results, as the distinction between positive staining for 

antibody and the background signal levels can be clearly seen. The pattern of AB presence follows 

the same shape and location as seen in Figure 20, which is very similar to the region where the 

BBB was disrupted during the final FUS treatment. These results are to be expected. Valdez et al. 

demonstrated that molecules larger than 70 kDa could not diffuse freely through the tissue and 

would instead diffuse slightly around the area of BBB disruption, but would stay localized. Since 

the IgG antibody used in this project is approximately 70 kDa, it was expected to be present in 

regions of BBB opening, with minimal diffusion of the AB to surrounding tissue. 

 These histology results raise some unexpected and interesting areas for further 

investigation. For example, the cause of −syn buildup in the region of BBB disruption is 

unknown. It was hypothesized that there would have been clearance of -syn in regions of BBB 

disruption, but Figure 20 clearly shows that the highest concentration of -syn is in the areas of 

BBB disruption. It is unknown if the cause of the -syn accumulation is due to FUS disrupting 

glymphatic or endocrine clearance pathways, if the -syn is binding to the AB present in the region 

of BBB disruption, or if the trauma associated with stretching tight junctions causes -syn to form 

transiently. It is also not known why -syn levels were lower outside of the BBB disruption region, 

or how the -syn was cleared from these areas. 
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5.4 Project Difficulties 

 This project experienced several setbacks due to the mouse model. There were numerous 

mouse deaths in transgenic mice, even when following previously recommended safety levels for 

FUS treatment. FUS safety levels were investigated using WT mice. In our own experiments, it 

was determined that 2 minutes of focused ultrasound in a scanning pattern was safe for multiple 

treatments spaced 2 weeks apart, and did not result in WT mouse death. When the experiment 

shifted to PD transgenic mice, there was a high mortality rate among transgenic mice when using 

that same method. FUS treatment was reduced to 30 seconds of scanning, which significantly 

decreased transgenic mouse mortality. 

 Although FUS treatment was more deleterious for transgenic mice than wild-type, the 

reduction of FUS to 30-seconds reduced the number of procedure-related mouse deaths. However, 

the transgenic PD mouse line had several other deaths, either spontaneous deaths where the mice 

were found dead in cage, during recovery after FUS treatment, or before FUS treatment while 

under anesthesia. There is no published literature characterizing the fragility of this mouse line, 

but mouse deaths were common across transgenic treatment groups, including the behavior only 

mouse cohort. These results indicate that the mouse line is exceptionally fragile and is not a 

suitable candidate for continued FUS research. Although the line 61 transgenic mouse can 

accurately model early-stage Parkinson’s Disease, the mouse line is not robust enough to survive 

FUS experiments or anesthesia, despite safety results demonstrated in wild-type mice. 

6.0 Future Directions 

 The work described in this thesis lays the foundation for a much larger longitudinal project 

looking at the efficacy of FUS and antibody therapy to ameliorate pathology and symptoms of PD 
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in the line 61 mouse model.  The longitudinal study includes wild-type and transgenic PD mice 

receiving different batteries of treatment, including PBS (control), PBS with FUS, antibody 

therapy, or antibody therapy with FUS. This study will use mice starting at 7 weeks of age and test 

for 12 weeks until the conclusion of the study.  Behavior testing will be conducted every two weeks 

on the mice, and the results will be compared against controls to determine if there were behavioral 

improvements or slower neuronal degeneration after receiving treatment.  At the conclusion of the 

study, the brains of each mouse will be extracted and analyzed for presence of -syn and neuronal 

health.  

 Other future directions could include using this method on a different mouse model for a 

similar Lewy-body neurodegenerative disease, such as multiple systems atrophy (MSA) or 

Alzheimer’s Disease. Although the model used in this study has motor and non-motor defects and 

physiology similar to late-stage Parkinson’s, the fragility of the mice and inconsistent results 

makes this model unsuitable for future work. The method of FUS as drug delivery mechanism is 

effective and could easily be transferred to other studies with antibody-based therapies. 

 Although this method was effective at opening the BBB in mice, there is still areas of 

focused ultrasound that need to be investigated for safety and better understanding of the effects 

of FUS on brain physiology. It has been shown that the BBB can be disrupted with FUS and 

microbubbles, but the exact cellular mechanism that facilitates the opening of the tight junctions 

is not known. Additionally, FUS has been shown to temporarily disrupt aquaporin receptors in 

astrocytic end-feet. The significance of this disruption has not been investigated, and the indirect 

effects of disrupted aquaporin receptors on bulk flow, toxin and waste clearance, and extracellular 

fluid transport in the brain has not been investigated. More work needs to be done to characterize 
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FUS as a delivery method, and to analyze the indirect effects of BBB disruption on blood flow, 

glymphatics, and bulk fluid transport.  

7.0 Conclusion 

 This project investigated the effects of antibody therapy which selectively targets toxic 

oligomeric forms of a-syn on a Parkinson’s Disease mouse model. The antibody was delivered 

using a novel focused ultrasound setup, which is able to transiently disrupt the BBB safely in mice. 

This project also investigated the effects of multiple treatments of FUS and AB therapy through 

behavior and histology results. The results from this project are promising and indicate that a larger 

longitudinal study will need to be completed to fully understand the effects of the AB FUS 

treatment on PD mice. The project also raised some new questions and provided interesting results 

that can be investigated in the future. This project contributed to the field of FUS by identifying 

safety thresholds for neurodegenerative disease mouse models, the effect of multiple sessions of 

FUS, and the efficacy of FUS as a drug delivery method for targeted therapeutics. 
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Appendix I 
 

Focused Ultrasound Mouse Brain Registration Standard Operating 

Procedure 
Updated 04/22/2021 

1. Create ROI of mouse brain and region of BBB opened 

a. Convert raw T1 coronal of mouse brain to Nifti (I used Mango, but any application will 

suffice) 

b. Open Mango and load converted nifti from 1.a 

c. Under Mango’s control panel, click on the crosshair (2nd icon from the right 

i. On the drop down menu, hover over the 3rd icon from the top 

ii. Select “trace region” 

 

d. Trace the brain to create an ROI for the brain only 
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i. Make sure to trace the brain on every slice 

 

e. Once the ROI covers the whole brain, double click on the ROI so that it is highlighted 

i. Click “file” -> “save ROI” 

f. Close the T1 coronal nifti 

g. Repeat steps 1.b-1.f with the region of BBB opened  

 

2. Extract ROIs from surrounding tissue 

a. Open the T1 coronal nifti 

b. Click “File” -> “Load ROI…” 

i. Select the whole-brain ROI created in steps 1.a-1.f 

c. Double-click on the ROI so that it is highlighted 

d. Click “Image” -> “Image Calculator” 

i. Under “Region” select “Outside ROI” 

ii. In the white box, type “this=this*0” 

iii. Click “Run Calculation” 
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iv. This will set the region outside of the ROI equal to 0 

 

e. Click “File” -> “Save As…” 

i. I generally save the nifti using the following format: 

mousenumber_treatmentletter_brain_only.nii.gz 

ii. Example: 0422_A_brain_only.nii.gz 

1. “A” indicates it was from the first treatment, “B” indicates the second 

treatment, etc. 

f. Close the image 

i. If Mango asks: “Save changes before closing? “ Click “No” 

ii. Clicking “Yes” Will delete the ROI 

3. Re-Slice Extracted Brain Nifti 

a. Open a terminal that has MRtrix3 downloaded 

i. I use MSYS MinGW 64bit (this is a shell application that emulates linux 

environment) 

b. Navigate to the directory containing the BBB ROI and the Extracted Brain Nifti 

i. Ex. cd c:MRI_Research/PD_Project/MRI_Data/stuff_to_process 

c. Once in the correct directory, type “mrgrid [brain only nifti] regrid – template [template 

nifti] [output nifti]” 

i. Replace the bracketed words with actual names 

ii. Ex. mrgrid 0422_A_brain_only.nii.gz regrid -template template_T2.nii.gz 

0422_A_resized.nii.gz 

4. Re-Slice BBB ROI 

a. Open the brain resized nifti (from step 3) using Mango 

b. Click “File” -> “Load ROI…” 

i. Select the BBB ROI created in step 1.g 
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c. Double-click on the ROI so that it is highlighted 

d. Click “Image” -> “Image Calculator” 

i. Under “Region” select “Outside ROI” 

ii. In the white box, type “this=this*0” 

iii. Click “Run Calculation” 

iv. This will set the region outside of the ROI equal to 0 

e. Click “File” -> “Save As…” 

i. I generally save the nifti using the following format: 

mousenumber_treatmentletter_BBB_resized.nii.gz 

ii. Example: 0422_A_BBB_resized.nii.gz 

f. “A” indicates it was from the first treatment, “B” indicates the second treatment, etc. 

5. Registration of brain only resized images and BBB resized images 

a. Open a terminal that has FSL installed 

i. I use Ubuntu power shell for Windows and installed FSL for Linux 

b. Navigate to the directory containing the resized BBB and resized brain only images 

i. Ex. cd /mnt/c/MRI_Research/PD_Project/MRI_Data/stuff_to_process 

c. Type the following command: “flirt -in [resized brain nifti] -ref [template nifti] -out 

[output nifti] -omat [output matrix name]” 

i. Change all of the bracketed names to proper names for files 

ii. Ex. flirt -in 0422_A_resized.nii.gz -ref template_T2.nii.gz -out 

0422_A_registered.nii.gz -omat 0422_A_matrix.mat 

d. Type “flirt -in [BBB resized nifi] -ref template_T2.nii.gz -applyxfm -interp 

nearestneighbour -init [matrix from 5.c.2] -out [BBB registered nifti]” 

i. Change the brackets to file names 

ii. Ex. flirt -in 0422_A_BBB_resized.nii.gz -ref template_T2.nii.gz -applyxfm -interp 

nearestneighbour -init 0422_A_matrix.mat -out 0422_A_BBB_registered.nii.gz 

6. Verify Registration Using MRview 

a. Click “File” -> “Open” 

i. Select the template image (template_T2.nii.gz) 

b. Click “Tool” -> “Overlay” 

i. Click on the file icon and select the registered brain (0422_A_registered.nii.gz) 

ii. Adjust the opacity so that the template image can be seen underneath 

iii. Un-check interpolate 
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1. If the overlayed image matches the template image fairly well, the 

registration was successful 

c. Un-check the box next to the overlay image 

d. Click the folder icon and select the registered BBB ROI (0422_A_BBB_registered.nii.gz) 

e. On the new overlay: 

i. Set scaling from [0-1] 

ii. Open colormap menu (the small colorbar under “Color map and Scaling” 

1. Click “ Custom Colour…” 

2. Select a color of your choice 

iii. Un-check interpolate 
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iv. Set opacity so that the template tissue structures can be observed through the 

ROI 

f. If the ROI location on the template image matches the BBB opening location on the raw 

nifti, the registration was successful 

g. Multiple ROIs can be loaded for multiple FUS treatments. Just follow step e for each 

new ROI and assign it a different color 
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